
5 Phases of Development

Phase 1

Development
Define Project

Determine Student Groups
Students Brainstorm

Students Pitch Project to Instructor
Submitting Written Materials
Instructor Approves Project

Students Write Script and Submit for Approval





Project Criteria

Project Deadline:

Export Format:

Special Instructions

Date:______________________

Purpose:

Subject:

Audience:

Project Duration:

CD-ROM DVD VHS Web Email

Other



Script
Visual Audio/Narration



EXAMPLE SCRIPT/SCREENPLAY

EXT. STREET OUTSIDE HOSPITAL - AFTERNOON MICHAEL DALEMAN,
an eight-year-old boy dressed in poor but clean clothes and
wearing an outdated pack sack, looks up at a large smoke
stack billowing white smoke on top of a small town
hospital. JORDAN and TYLER, two ten-year-old boys, approach
Michael.

TYLER

Hi Michael
They elbow one another and join Michael looking
up at the smoke stack. Tyler says teasingly…

TYLER

That's where they burn parts of people.

Michael turns to him, wide eyed.

TYLER
There's a big fire-furnace in the basement where
they burn 'em.

JORDAN joins in the teasing.

Taken from “The Director in the Classroom” by Nikos
Theodosakis



5 Phases of Development

Phase 2

Pre-Production
Students Storyboard and Submit for Approval

Students Prepare Breakdown Requirements
Students Create Props

Students Arrange Filming



Storyboards

Notes: Notes:

Notes: Notes:

Notes: Notes:



Storyboard - Single
Shot/Scene #

Location

Timecode Start

Timecode End

Title:

Camera Direction:

Narration:

Notes/Comments



Shot/Scene # Description Timecode Start Timecode Finish Mark as

Shot List



5 Phases of Development

Phase 3

Production
Students Sign Out Equipment

Students Record Video and Audio
Students Return Equipment

Students Submit Production Reports



5 Phases of Development

Phase 4

Post-Production
Footage is imported into an editing program

(iMovie, Movie Maker 2, etc.)
Editing

Test Screening
Revisions

Export Project
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iMovie at a Glance

 

“iMovie at a Glance” introduces you to the controls in the iMovie window. You use these controls 
to create your own movies. Take a look at these pages even if you don’t plan to do the tutorial, 
because you’ll need to know the names of the iMovie controls to follow instructions in 
iMovie Help.

The pages that follow introduce you to the main iMovie window, the timeline and clip viewers, 
and the different panes you use to add professional polish to your movie.
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iMovie Window

 

A

 

iMovie monitor:

 

  Watch your clips play in this window. You can play clips that are in the Clips pane or the 
clip viewer.

 

B

 

Scrubber bar:

 

  Drag the playhead along the scrubber bar to move through a clip frame by frame. The number 
near the playhead indicates how far (minutes:seconds:frames) the selected frame is into the movie.

 

C

 

Mode switch:

 

  Click to switch between camera mode and edit mode. Use camera mode to choose an input 
device and transfer your raw video into the computer. Use edit mode to work on your movie.

 

D

 

Playback controls:

 

  Use these controls to skip to the beginning of a selected clip, play the clip in the iMovie 
monitor, or play the clip full screen on your computer’s monitor.

 

E

 

Volume slider:

 

  Slide this control to change the volume of the computer’s speaker while you work in iMovie. 
This won’t change the volume levels in your video or audio clips.

 

F

 

Pane buttons:

 

  Click these buttons to see the different panes of the iMovie window. See a description of each 
pane later in this document.

 

G

 

Trash:

 

  Drag unwanted clips to the Trash icon to delete them. You can restore cropped video and audio from 
the iMovie Trash if you haven’t emptied it.

 

H

 

Disk space indicator:

 

  Monitor your free disk space as you work. You should always have about 2 GB free disk 
space for optimal performance of iMovie. When this bar turns yellow, you are starting to run low on disk 
space. When it turns red, you must free up some space to continue working on your movie.

A

C

B

D E F

G H
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Clip Viewer

 

Use the clip viewer, shown below, to add clips to your movie and arrange them in the order you 
want them to appear in your movie. When you create titles and transitions, or add photographs 
from your iPhoto library, drag them to the clip viewer.

 

Timeline Viewer

 

Use the timeline viewer, shown below, to work with audio clips, synchronize your audio with 
video, and to adjust the timing of your movie.

 

A

 

Clip viewer button:

 

  Click the clip viewer button to switch from the timeline viewer.

 

B

 

Clip:

 

  Each section of video footage and any still images you import are called clips.

 

C

 

Transition marker:

 

  Transition markers indicate that two clips are linked by a transition.

A

B

C

 

A

 

Timeline viewer button:

 

  Click the timeline viewer button to switch from the clip viewer.

 

B

 

Video track:

 

  Select clips in this track to add motion effects.

 

C

 

Audio tracks:

 

  Place and arrange audio clips in these tracks to synchronize audio and video clips. Deselecting 
the checkbox to the right of the track mutes all the audio clips in that track.

 

D

 

Zoom slider:

 

  Move the slider to make clips appear larger or smaller in the timeline.

 

E

 

Clip speed slider:

 

  Select a video clip and drag this slider to make the clip play faster or slower.

 

F

 

Edit Volume:

 

  Select this checkbox to see the volume level bar for all clips. Move the slider to raise or lower 
the volume of a selected clip or clip segment.

 

G

 

Volume level bar:

 

  Click this bar to add markers, then drag the markers to adjust the volume for sections of 
audio clips. You can use this to make audio fade in or fade out.

 

H

 

Audio waveforms:

 

  Representations of audio intensity. Use audio waveforms to align video to audio events 
such as a certain drumbeat or the exact beginning or end of the audio.

 

I

 

Audio checkboxes:

 

  Select a checkbox to hear the audio in its track. Deselect it to mute the track.

A

B

C
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Clips Pane

 

Click the Clips button to open the Clips pane. The video footage and still images you import into 
iMovie are stored here.

 

A

 

Clip name:

 

  Each clip is assigned a unique filename. Double-click the name to change it to something more 
meaningful to you. You can drag a clip from the Clips pane to the clip viewer to add it to your movie.

 

B

 

Duration:

 

  The length of a video or audio clip is read as minutes:seconds:frames. For example, 01:08:15 is 
1 minute, 8 seconds, and 15 frames into the movie.

A

B
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Photos Pane

 

Click the Photos button to open the Photos pane. You can import an image directly from your 
iPhoto library, add pan and zoom effects to it, and choose how long you want the photo to show 
in your movie.

 

A

 

Ken Burns Effect:

 

  Use these controls to set up pan and zoom effects for your photographs. Turn the effect off 
or on by selecting or deselecting the Ken Burns Effect checkbox. Click Start and Finish to set which part of 
the photo is showing at the beginning and end of the effect. Use the Zoom slider to set the zoom.

 

B

 

Reverse:

 

  Click to reverse the direction of the pan and zoom effect.

 

C

 

Preview:

 

  Click to see how the effect looks in the preview monitor.

 

D

 

Apply:

 

  When you have the effect the way you want, click this button to apply the effect to the photograph. 
This creates a new clip in the Clips pane that you can add to your movie.

 

E

 

Duration:

 

  Move the slider to set how many seconds the photograph remains in view.

 

F

 

iPhoto pop-up menu:

 

  Choose your iPhoto library or an iPhoto album from this menu to view and select 
photographs. You can drag a photograph from the Photos pane to the clip viewer to add it to your movie.

 

G

 

Preview monitor:

 

  Use this monitor to set up and preview effects for a selected photograph.

F

G

A

B
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D

E
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Audio Pane

 

Click the Audio button to open the Audio pane. You can add sound effects, record a voiceover, or 
import music from a CD or your iTunes music library.

 

A

 

Audio pop-up menu:

 

  Choose the source from which you want to import music or audio. You can choose a 
track from your iTunes library or a music CD, or an iMovie sound effect. You can drag a sound effect or 
iTunes track from the list to the timeline viewer to add it to your movie.

 

B

 

Eject button:

 

  Click the button to eject a CD from the optical drive.

 

C

 

Play:

 

  Click the button to play or pause a selected track.

 

D

 

Search field:

 

  Type some words from a title to search for a particular audio file in your iTunes library. You can 
search by title or artist.

 

E

 

Place at Playhead:

 

  Click the button to import a selected track into your movie. The imported track appears in 
one of the audio tracks in the timeline viewer.

 

F

 

Record/Stop:

 

  Click the button to record a voiceover or other sound through your computer’s built-in 
microphone or an external microphone. The input meter displays the sound level; sound quality is best if it 
stays within the yellow range.

A
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E
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Titles Pane

 

Click the Titles button to open the Titles pane. You can add opening titles, rolling commentary, or 
end credits. You can also choose a title style, font, and text color.

 

A

 

Preview:

 

  Click to see how the title will look.

 

B

 

Update:

 

  Click to apply changes to a title you’ve already added to your movie.

 

C

 

Arrow buttons:

 

  For some titles you can click the arrow button to set the direction you want the title to move.

 

D

 

Preview monitor:

 

  Use this monitor to view title styles and preview your settings.

 

E

 

Timing controls:

 

  Move the sliders to set how quickly you want the titles to appear and how long to pause 
before disappearing. Other options may be available, depending on the title style.

 

F

 

Titles list:

 

  Select a title style for the text you want to add to your movie. Click the arrow next to a title to see 
more titles in that category. When you’re done setting options for the title, drag the title style from this list to 
the timeline viewer to place the title in your movie.

 

G

 

Font controls:

 

  Choose a font, then move the slider left or right to adjust the font size. Choose a font color 
using the color box.

 

H

 

Over Black:

 

  Select this option if you want the title to appear over a black video clip instead of one of your 
video clips.

 

I

 

QT Margins:

 

  Select this option if you plan to export the movie to QuickTime. Deselect it if you want to show 
the movie on a television screen.

 

J

 

Text fields:

 

  Type your text in these text fields. If the style you choose allows more lines of text, use the plus 
and minus buttons to add or remove lines of text.

D

E

C

I
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Transitions Pane

 

Click the Transitions button to open the Transitions pane. You can add transitions to move 
smoothly between the scenes in your movie.

 

A

 

Preview:

 

  Click to see how the transition will look in the iMovie monitor.

 

B

 

Update:

 

  Click to apply changes to a transition you’ve already added to your movie.

 

C

 

Apply:

 

  Click to apply the transition to multiple selected clips in your movie.

 

D

 

Arrow buttons:

 

  For some transitions, you can click an arrow button to set the direction you want the 
transition to move.

 

E

 

Timing controls:

 

  Move the sliders to set the speed of the transition and make other adjustments, depending 
on the transition style.

 

F

 

Preview monitor:

 

  View a selected video clip and transition here.

 

G

 

Transitions list:

 

  Select a transition in this list. When you’re done setting options for the transition, drag the 
transition from this list to where you want it to appear in the clip viewer.

G

F

C

E
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B

D
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Effects Pane

 

Click the Effects button to open the Effects pane, where you can add special effects to change 
the look of your movie clips. For example, you can change color video to black and white, adjust 
the image brightness and contrast, or add playful effects like fairy dust or rain.

 

A

 

Preview:

 

  Click to see how the effect will appear in the selected clip.

 

B

 

Apply:

 

  Click to apply the effect to the selected clip in your movie.

 

C

 

Effect In/Effect Out:

 

  Move these sliders to the points in the selected clip where you want 
the effect to appear and disappear.

 

D

 

Preview monitor:

 

  Use this monitor to preview the effects you set up.

 

E

 

Effects list:

 

  Select an effect in this list to change the appearance of clips in your movie.

 

F

 

Appearance controls:

 

  Move these sliders to make adjustments to the selected effect. 
These options will vary, depending on the effect you choose.

E

D

F

A

B

C



 

iDVD Pane

 

Click the iDVD button to open the iDVD pane. You can add chapter markers to your movie and 
export it to iDVD.

 

A

 

Chapter titles:

 

  A new chapter appears in the list each time you add a marker. Type a name for each chapter 
that you want to use in your iDVD scene selection menu.

 

B

 

Add Chapter/Remove Chapter:

 

  Click to add or remove a chapter marker in your movie. If you export your 
movie to iDVD to create a DVD, the markers you add are used to create scene selection menus in iDVD.

 

C

 

Create iDVD Project:

 

  Click to export your movie directly to iDVD. This opens iDVD version 3 or later and your 
movie appears as a project in the iDVD window. If you don’t have iDVD version 3 or later on your computer 
or you don’t have a supported DVD drive, this button is not available.

B

A

C
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IT > Software > MovieMaker 

 

Movie Maker Tutorial 
 Overview. 

 Getting the Raw Material for the Movie. 

 Importing the Files. 

 Editing the Raw Material to Make a Movie.  

 Organizing the Clips. 

 Trimming the Clips. 

 Adding Titles. 

 Video Effects and Transitions. 

 Adding Narration and Audio File. 

 Rendering the Final Result.  

 Miscellaneous.  

 Troubleshooting. 

Overview  

There are four basic steps to creating a movie in Windows Movie Maker 2 on a Windows XP 
computer with the ATI Allinwonder board and an attached VCR: 

 Get the original images, sounds, and film clips on the computer; 
 Import them into a Movie Maker "collection;" 
 Edit the clips by arranging them in order, trimming them, adding titles and narration 

and any special effects; and 
 Render the result, converting it into a movie that can be stored on the computer's hard 

drive, a CD, or the web. 

Only the first of these requires the ATI Allinwonder board. The remaining steps can be carried 
out on any XP computer. The movies can be viewed with Windows Media Player. Campus 
copyright policies are available online on the Library website and on the Dean of Faculty 
website. 

Creating the Raw Material for the Movie  

Movie Maker 2 can make use of image files, audio files, and movie files. Image files and audio 



files (aside from narration) are created using other applications. We suggest moving them to a 
folder on your U drive so that they will be accessible from any computer on campus you choose 
to use. Once you have begun to create a movie using a set of files, do not move them. Movie 
Maker 2 does not copy these files into a new location when it imports them, but simply makes a 
pointer to them. 

One way to create movie files is to use the ATI board to capture segments of a movie from the 
VCR. Another is to use a video camera and download from the camera to the computer. 

To capture video from a tape, load the tape into the VCR. On most systems, start the TV 
application by selecting it from Start -> All Programs -> ATI Multimedia Center. On some 
systems maintained by the IT department, you will need to go Start -> All Programs -> 
Media Tools -> TV. A large blank window will appear. this will show the video during 
recording. Beneath that will be the control panel. 

 

While this control gives you many options, most of the time you will only need to use one or 

two. The most important is the Start Recording icon, , which you use to both start and 
stop the capture process. 

In order to capture video, the TV application must be in the correct mode. The word 
"Composite" should appear in the center of the screen as shown below. If the screen also 

displays "Live," then you need to click the mode icon. , on the far left of the panel to 
toggle back to the correct mode for video capture. 

Start the video using the contros on the VCR. Click the Start Recording icon to start the 
recording process. When video capture begins, the screen turns black for a couple of seconds. 
Capture begins when the video signal returns. Thus you should begin your capture several 
seconds before the first frame you want. You may fine it easier to pause the video tape (using 
the VCR controls) just before the point you want to start recording, then click the Start 
Recording icon and finally restart the video. It is better to record more material than you need 
that to record less. Editing the clip down later is fairly simple.  

Once you start recording a status display will appear on the screen. When you have recorded 
the entire clip, click on the Start Recording icon again to end recording. Stop the videotape. 



The box below summarizes the steps in video capture. 

 Load the videotape. 
 Start the TV program. 
 Start the videotape.  
 Go to the point in the tape where you want to 

start recording. 
 Begin the capture with the Start Recording 

icon. 
 End the capture with the Start Recording 

icon. 
 Stop the videotape. 

When you are finished capturing the video sequences you want, exit the TV application. The 
video segments you've captured will be stored in the My Documents/My Videos folder on the 
computer with filenames like "Composite (Dec 9).wmv." You should probably rename these 
files to something that will help you remember the contents of the clip. Remember to keep the 
".wmv" ending on the filename. You may also want to copy the clips to your U drive for safety. 
This also allows you to edit the clips on another computer. 

If instead of capturing video from a videotape, you want to download it from a video camera, 
this can be done in a couple of different ways. The details depend somewhat on the camera you 
are using. One way is to connect the camera to the VCR using a cable with red, white, and 
yellow connectors at one end, and plug those connectors into the red, white, and yellow jacks 
on the front of the VCR. Play the movie in the camera through the VCR and capture it just as 
you did with the videotape. 

Importing the Files  

To import the files into Movie Maker, start Movie Maker and select Import from the File menu. 
Browse to the files you want to use and import them one by one. As you import the files, you 
can have Movie Maker you have the option of having Movie Maker automatically divide the 
movie segments into smaller individual clips to facilitate editing. If you want clips created, 
make sure the small box at the bottom of the Import screen is checked. If you want your video 
segments intact, uncheck the box. Remember that "importing" files in Movie Maker means 
creating links in Movie Maker to the actual locations of the files. To work with the clips in Movie 
Maker, you must have access to the original location. For example, if the files are on a CD, you 
must keep the CD in the CD drive.  

As you import the files, you will see them appear in the center pane of the program display as 
illustrated below. The left pane lists your various collections. The center pane shows the clips 
you've imported. The right pane displays a working version of the clip or clips you're working 
on. The bottom pane is the storyboard. In this screen shot, the first image has been dragged 
into place on the storyboard. 



 

If you had Movie Maker divide a clip into segments during import, the video segments will 
appear as a series of smaller clips in a reasonably intelligent fashion. During the editing 
process, you will be able to arrange the clips in order, trim them, and join multiple clips 
together. You will also be able to combine clips from different collections. None of the editing 
you do will affect the original clips. What Movie Maker stores is the sequence of operations you 
perform on them. 

You can also import image and sound files into collections. 

Editing the Raw Material to Make a Movie  

This is where you'll probably spend the most time. The basic steps here are: 

 Moving the clips and still images into place on the storyboard; 



 Trimming the clips so that they include just the frames you want; 
 Adding short titles or credits at the beginning or end of the clips or between them; 
 Adding special effects and transition effects; and 
 Adding narration and audio files. 

Since this process can take some time, you may want to stop and store what you've done so 
that you can pick it up later. This is done by saving the current state of your movie as a project 
file. Project files have a .mswmm extension. 

Organizing the clips  

If you have divided a larger clip into segments, you may find it easier to work with them if you 
give them meaningful names before you begin arranging them on the storyboard. To rename a 
clip, right-click on the name and select Rename from the drop-down menu. 

The first step in creating a movie is to drag the clips and any still images into place on the 
storyboard at the bottom of the window. If you click on the magnifying glass icon with a + next 
to it, the timeline for the storyboard will enlarge so that you can see a thumbnail image right 
on the storyboard. If at any time you decide you want to switch clips or images around, you 
can simply drag them into a new position with the mouse.  

The storyboard at the bottom of the screen can be viewed in two slightly different formats. The 
storyboard view shows larger thumbnails of all clips and titles with an easy-to-see place to drag 
transition effects and to display the effects that are in place. The timeline view compresses the 
thumbs and provides a timeline ruler that shows the duration of all clips. In addition, the 
timeline must be used when adding audio. The magnifying glass icons compress or expand the 
timeline view. 

At any point, you can view the entire movie so far in the video pane on the right. 

Trimming the clips  

The next step is probably trimming the clips, although you can jump back and forth between 
the various editing tasks as you like. Select a clip on the storyboard. If you need to trim a 
substantial segment, you can do so right on the storyboard by clicking on the clip and then 
dragging the small triangles at either the beginning or end of the clip towards the middle.  

If you want better control, you can play the clip frame by frame and specify the exact 
beginning and end. Begin by selecting the clip you want to trim on the storyboard. The first 
frame will appear in the right-hand window--the one that is black in the screen shot above. 
Play the clip until you reach the approximate point at which you want to clip, then use 
ALT+LEFT-ARROW and Alt+RIGHT-ARROW to move frame by frame until you find the exact 
spot. Now go the the Clip menu and select Set Start Trim Point. Do the same to locate the 
point at which you want to trim the end and then select Set End Trim Point from the Clip 
menu. Remember that your original clips are not trimmed. What is stored are the instructions 
for where to trim each clip. The clip menu also allows you to split a single clip into two clips or 
to combine two adjacent clips together. 



Adding titles  

Frames containing text can be added before or after any clip or still image. Each frame can hold 
only a limited amount of text, so inserting multiple paragraphs of text may require using 
several successive frames with few sentences on each frame. You can specify the color of the 
text and background as well as the text font. It is also possible to make the text partially 
transparent and position it on top of the film. Finally, this can be used to make a simple black 
delimiter frame that can be copied and pasted between a sequence of clips. 

To add titles, select the appropriate clip in the storyboard. Select Titles and Credits from the 
Tools menu. Select whether you want to add the text before or after that clip. The next screen 
will display the text entry window(s). As you enter text, the font size will adjust automatically 
to fill the frame. Unfortunately, the text-entry boxes can hold more text than may appear. This 
is font-dependent. 

There are a variety of title animations, some of which use one text window and others that use 
two text windows. The default is for two text windows - a title area and a subtitle area. The 
various formats and animations allow for a variety to different presentations of text. A little 
experimentation here will illustrate the possibilities. 

It is also possible to superimpose titles on the clips to function as subtitles. However, they are 
automatically positioned in the lower third of the screen and it's not possible to fine-tune their 
placement for good visibility. 

Video Effects and Transitions  

The Tools menu is also used to create video effects and video transitions. Video effects are 
effects applied to the actual video clips and include effects such as rotating the frames, color-
cycling, as well as fades. They are applied to clips. Transitions are inserted between clips and 
affect the way the end of one clip turns into the beginning of the other. Some examples are 
page curls, wiping up, swirling in, etc. Again, a little experimentation here will illustrate the 
possibilities. 

Adding Narration and Audio Files  

In order to add narration or audio files to your movie, you must have the storyboard in timeline 
view. If you want to add an audio file, use the File menu to import it into your collection. Then 
drag it down to the Audio/Music layer in the storyboard. If the audio clip is longer than the 
movie,you can clip the end of it by using the mouse and dragging the right end to the left. To 
fade the audio in or out, select Audio from the Clip menu and turn on or off the options. 
Adding an audio track with NOT mute any sound in the clip itself. 

Since narration uses the same channel as audio, you cannot have both music and narration at 
the same time. To create narration clips, select Narrate Timeline from the Tools menu. 
Position the vertical selection bar at the point in the storyboard at which you want the narration 
to begin. Start playing the movie, press the Start Narration button and begin speaking into 
the microphone. Click stop narration when you're done. When you click the Done link, you'll be 
asked to give a title to the narration clip, and will return to the normal view. Your narration clip 



will be in the collection and will be positioned in place on the storyboard.  

Rendering the Final Result  

The final step is to have Movie Maker render all the clips, stills, transitions, and effects into a 
movie. This can take several minutes to an hour or more depending on the length of the movie, 
so plan for it. If you have done a lot of work and don't want to have to start from scratch again 
if you want to make a small change, save your work as a project first. Then if you do decide to 
make a change, you can pick up from this point. 

To render your movie, select Save Movie File from the File menu. A wizard will walk you 
through the few steps needed. You will be asked where you want to save the movie too. Almost 
always you want to select My Computer. Even if you plan to put the movie on the web, don't 
select The Web option. This option only allows save to a few commerical web services.  

Next you we need to name the move. ".wmv" will be added automatically if you don't include it 
at the end of the movie name. You can also select the file location where you want to store the 
movie. 

Finally you get to select the format of the file. Most of the time "Best quality for playback on 
my machine" is fine. If, however, you expect someone to download the movie over a modem, 
you may want to try one of the other possibities that will general small files by either reducing 
image quality or image size. 

Miscellaneous  

To capture a frame of a movie as a still, move to that frame using ALT plus the left and right 
arrow keys. Select Take Picture from Preview under Tools. You will be prompted to save the 
image and it will automatically be imported into the current collection. 

It is possible to use Movie Maker to create an automatic slideshow of images. Import the 
images into a collection, arrange them on the storyboard and insert title frames and transitions 
if you want. If you would like the images to remain on view for longer than the default, you can 
drag the right side of the image to the right in the storyboard.  

Troubleshooting  

1. The Help menus are generally quite good in Movie Maker. 

2. Some videotapes are copy-protected with Macromedia. This may not be marked in any 
visible way on the tape itself. However, if you try to capture it, the captured video may loop 
every couple of seconds.  

3. There have been reports of systems crashing because of conflicts with files called DIV*.AX 
and of problems running on systems with hardware accelerators. 



4. Check the cable connections.  

5. There is an active newsgroup for Movie Maker questions, 
microsoft.public.windowsxp.moviemaker. You can subscribe to newsgroups in Netscape 
Messenger. 

   

 



Section 1:  The Windows Movie Maker 2 Interface 
  
Before making our first movie in WMM2, let’s familiarize ourselves with the interface.  
Here are the basic areas of the WMM2 workscreen: 
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1. This is the “Menu Window” in WMM2.  If you’ve selected TASKS at the top of 

the screen (see #7), this window will show you a list of tasks you can do in Movie 
Maker.  (Import video, make snappy titles or credits, etc.)  If you’ve selected 
COLLECTIONS at the top of the screen (#7 again), you will see sets of different 
elements you can add to your movie (transitions, clips, etc.)  

 
2. This is the “View Window” or “Collections Window.” Here you will see 

thumbnails of what you have selected in the Menu Window.  In our example, I 
have highlighted “Photostory 1,” in the Menu Window, and the View Window is 
showing the clips contained in that folder. 

 
3. This is the “Preview Window.”  Notice that it has VCR-type controls to play 

media (#6.)  You can preview clips here by selecting the folder that contains them 
in the Menu Window (#1) then double-clicking on the thumbnail of the clip in the 
View Window (#2) that you would like to see.  Or, if you have started building 



your movie on the Timeline (4), you can use the play controls to preview your 
movie. 

 
4. This is the Timeline-Storyboard  area, sometimes called the “Editing Window.”  

You toggle between timeline and storyboard mode by clicking on the mode-
changing button (to the right of #5.)  Notice that in our illustration, we are looking 
at the Timeline (which shows us the duration of each clip, the audio tracks, etc.).  
If we were looking at the storyboard mode, we would see a “building block” chart 
showing each clip, transition, etc.   

 
5. The mode-changing button.  (See #4.) 

 
6. VCR play controls for the preview window. (See #3.) 

 
7. Switch between Collections and Tasks  in the Menu window.  (See #1.) 
 
If all of this feels too complex, just remember that the two choices that affect how 
WMM2 looks are items 5 and 7.  Here’s how the screen would look if I had selected 
Tasks instead of Collections at the top of the screen, and Storyboard instead of 
Timeline  above the Editing Window: 
 
 

 
 
 Notice that 

TASKS  has 
been 
selected 

 
 
 

Notice that STORYBOARD has 
been selected.  We’re now seeing 
the sequence of clips and 
transitions.  If we wanted to edit 
any of those clips, we would click 
here to select TIMELINE MODE. 

 
 Selecting TASKS puts a 

list of different things you 
can do to your movie in 
Menu Window. 

the 
 
 
 
 
 
 
 

 
 
 

 
Once you’re familiar with the interface, you’re ready for your first movie.  In the next 
section, we’ll cover making a simple movie in WMM2 from start to finish. 
 
 
 



 
Section 2:  Making A Movie 

Part 1:  Importing video 
 
Before you start WMM2, plug your camera into the computer using the firewire cable, 
and turn the camera on in VCR (play) mode. 
 
Windows XP should recognize the camera, and will pop up this dialog box: 
 

 

When you select the option to Capture 
Video using Windows Movie Maker, 
XP will start Movie Maker for you and 
check your camera. 

 
 
Movie Maker 2  then asks you a few questions about how to capture and store your video. 
 

 

Assign a name to your captured 
video file, tell the computer 
where to store it, then click the 
Next button. 



 
Next you set the quality of your capture.   
 

 
 

 

Recommended:  Select the DV-
AVI format when importing 
video.  It is more compatible 
with other editing systems, and 
you keep the option of being 
able to store your finished 
movie on tape.  This is a more 
widely recognized format than 
the top choice on this screen, 
but the files do take a lot of 
space.  (Note that the Video 
File Size box in the lower right 
tells you that each minute of 
captured video will take 178 
Mb of space.) 

When you click on the Next button at the bottom of this box, you are taken to the Main 
Capture Screen. 
 

 

Use these Play Controls to 
cue the tape to the start of 
the segment you want to 
import.  Then click the 
Start Capture button to the 
left of the screen.  When 
you have captured your 
clip, click Stop Capture.  
You may then use the Play 
Controls to cue the tape to 
the next segment to 
capture, or if you’re done, 
click the Finish button at 
the bottom of the window. 



   
Part 2: Making a rough cut of your movie. 
 
Now that you have clips to work with, you can make a “first draft” of your movie by 
clicking on the clips showing in the Collections Window and dragging them to the 
bottom of the screen to place them on the timeline.  Here’s how your screen should look 
after you’ve dragged a few clips to the timeline: 
 

 

 
length. 

This arrow 
marks the 
beginning of the 
clip.  By 
dragging it to the  
right, you can 
shorten your 
clip. 

This black arrow 
marks the end of the 
clip.  By dragging it to 
the left, you can shave 
seconds off the clip’s

 
First, edit your clips for length.  To make a clip shorter, you can drag the “Inpoint” and 
“Outpoint” markers on the left or right side of the clip. 
 
Notice that the audio you recorded with your video was also imported, and it is on a 
separate track on the timeline.  You can delete the audio, or change its volume.  You can 
also make the audio fade in at the beginning of a clip and/or fade out at the end by right-
clicking on the audio segment you want to fade and selecting the appropriate command. 
 
WMM2 allows you to add background music by selecting the Import audio or music 
option in the menu window. 
 
 
 
 
 



 
Part  3:  Spicing your movie up with transitions, effects, titles and end credits. 
 
Hint:  it’s best to use these enhancements sparingly.  Throwing too many jazzy titles, 
transitions and effects into your movie will detract from its content, and it will annoy the 
viewer. 
 
WMM2 offers a wide variety of transitions you can use to smooth the jump from one clip 
to the next.  To access them, go to the Menu Window, Section 2:  Edit Movie, and select 
View Video Transitions.  You can then preview a transition by double-clicking on it in 
the Collection Window.  Once you find one you like, drag it to the timeline to add it to 
your movie.  (Hint:  some people find it easier to add transitions when they’re in 
Storyboard  mode.) 
 
Effects differ from transitions in that they are applied to the whole clip, not just the end 
points.  They are a useful, quick way to fix problems with your clips (you can lighten 
video that is too dark, for example) or apply an artistic effect.  The procedure for using 
them is similar to using transitions:  in the Menu Window, Section 2 select View Video 
Effects.  Preview the effect, then drag it over a clip to apply it.  (Hint:  some effects can 
be applied multiple times to a clip.  For example, you can apply the “Lighten” effect 
several times to make the clip lighter, or you could apply the “Slow Down” effect several 
times for a really sloth-like slow-mo.) 
 
WMM2 has an extensive selection of titling and end credit effects.  To access them, go to 
Section 2 of the Menu Window again and select Make Titles or Credits.  Spend some 
time experimenting with the options here.  You can change the color, font, and style of 
the text, the color or content of the background, and the animation.  Select the style that’s 
best for your movie.  (Hint:  be sure to check out the “Scroll-Perspective” animation for 
titles---with very little effort, you can create “Star Wars” style scrolling text titles.) 
 
 

Section 3:  Saving your movie. 
 

 
There are several different options for saving your finished movie.  They are listed under 
Section 3 of the Menu Window.  Select the appropriate storage option, and follow the 
prompts.   
 
There are a few things to keep in mind about saving movies.  In WMM2, the default 
format for saving your movies is WMV format.  This compresses your movies so they 
take up less space on the hard drive or CD you’re sending them to.  For example, a movie 
that takes 20 Mb of space in WMV format can easily take more than 400 Mb. if you save 
it in the AVI format.   
 
There are some drawbacks to WMV, however.  Sometimes you won’t get as high quality 
playback of your movie as you would in AVI format, especially if your movie contains 



still photos, animations, or a lot of other special effects.  Also,  many video editing 
programs have problems importing and using WMV format files because of their severe 
compression. 
 
If you’re saving to your hard drive and can spare the space, it is recommended that you 
store your finished movie in AVI format.  (I also recommend that you back up your 
finished movie to a new tape in your DV camera, since that will store it offline in AVI 
format so you could recapture parts or all of it later.)  To store your movie on the hard 
drive in AVI, you should select the Save to My Computer under the Save Movie options 
in the Movie Task Menu.  When you do, this window should appear: 
 

 
When you first 
see this window, i
will probably be 
showing the 
default selection 
of Best Quality 
for playback on 
my computer (the 
first button.)  
Click on the scroll 
window by Other 
Settings to bring 
up a menu of 
other choices, and 
select DV-AVI 
(NTSC)  as s
in the illustrati

 

t 

hown 
on. 
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Phase 5

Distribution
Premiere

Evaluation



Student Name ________________________________

Storyboard Rubric

Objective 4 – excellent 3 – good 2 – fair 1 – poor Pts
Organization of
boards

All sketches are
organized and
numbered in a
logical sequence
based on the final
script.

Most sketches
are organized and
numbered in a
logical sequence
based on the final
script.

Some sketches
are organized
and numbered in
a logical
sequence based
on the final
script.

None of the
sketches are
organized and
numbered in a
logical sequence
based on the final
script.

Setting The setting is
discernable in all
sketches

The setting is
discernable in
most of the
sketches.

The setting is
discernable in
some of the
sketches.

The setting is not
discernable in the
sketches.

Action In all of the
sketches you can
tell what action is
taking place.

In most of the
sketches you can
tell what action is
taking place.

In some of the
sketches you can
tell what action
is taking place.

It is difficult to
tell what action is
taking place in
most of the
sketches.

Color All of the
sketches use
multiple colors
that are
appropriate for
the visual setting

Most of the
sketches use
multiple colors
that are
appropriate for
the visual setting

Some of the
sketches use
multiple colors
that are
appropriate for
the visual setting

The sketches do
not use multiple
colors that are
appropriate for
the visual setting.

Communicates
ideas visually

The sketches
visually
communicate the
final script very
well.

The sketches
visually
communicate
most of the ideas
from the final
script.

The sketches
visually
communicate
some of the ideas
from the final
script.

The sketches do
not visually
communicate the
ideas of the final
script very well.

Total Points
for

Storyboard
   20



Student Name ________________________________

Video Rubric

Objective 4 – excellent 3 – good 2 – fair 1 – poor Pts.
Transitions Has at least 4

transitions that
are consistent
with the
storyline based
on the script
and
storyboards.

Has at least 3
transitions
that are
consistent
with the
storyline
based on the
script and
storyboards.

Has at least 2
transitions
that are
consistent
with the
storyline
based on the
script and
storyboards.

Has at least 1
transition that is
consistent with the
storyline based on
the script and
storyboards.

Titling Has at least 4
titles that are
consistent with
the storyline
based on the
script and
storyboards.

Has at least 3
titles that are
consistent
with the
storyline
based on the
script and
storyboards.

Has at least 2
titles that are
consistent
with the
storyline
based on the
script and
storyboards.

Has at least 1 title
that is consistent
with the storyline
based on the script
and storyboards.

Storyline/plot All video clips
fit the storyline
based on the
script and
storyboards.
Clips are just
long enough to
make each
point clear. The
pace captures
audience
attention.

Most video
clips fit the
storyline and
tell a complete
story based
on the script
and
storyboards

Video clips
used need to
be edited to
assist in
telling the
story from the
script and
storyboards.

The video clips do
not fit the storyline
laid out by the
script and
storyboards.

Audio and/or
Narration

The audio is
clear and
effectively
assists in
communicating
the main idea.

The audio is
clear, but only
partially
assists in
communicatin
g the main
idea

The audio is
inconsistent in
clarity (too
loud/too
soft/garbled)
at times and
insufficiently
communicates
the main idea

Audio is cut-off
and inconsistent. It
does not assist in
communicating the
idea of the video

Total Points for
Video



Filmmaking in the
Classroom

Resources
Worksheets

Articles



 

 

Cinematographer 
 

Cinematographer 

 

Cinematographer 

 

Cinematographer 

 

Cinematographer 

 

Cinematographer 



 

Spokesperson 
 

Spokesperson 

 

Spokesperson 
 

Spokesperson 

 

Spokesperson 
 

Spokesperson 



 

 

Director 
 

Director 

 

Director 
 

Director 

 

Director 

 

Production 
Assistant 



 

What does a DIRECTOR do? 
 

• suggest where the 
spokesperson should 
sit/stand 

 
• decide where the camera 

should be 
 
• start the action! 
 
• handle the mouse and 

keyboard during editing 



What does a 
CINEMATOGRAPHER do? 

 
• hold the camera 

 
• adjust the volume 

 
• swivel the camera to film 

scenes just right 
 
• press “record” and “stop” 

 
• rewind the tape to play back 

scenes you recorded 
 



What does a PRODUCTION 
ASSISTANT do? 

 
• know how to be a director, 

spokesperson, and 
cinematographer 

 
• fill in as a substitute if 

someone is absent 
 
• be the assistant to the 

producer (the teacher) 
 
• become an expert on the 

computer (to help the teams) 



What does a SPOKESPERSON 
do? 

 
• practice speaking lines until 

they’re memorized 
 
• look into the camera lens (or 

other special place) 
 
• speak LOUDLY! 

 
• appear in the movie 



 
 

_______________________________
_______________________________
_______________________________
_______________________________
_______________________________ 

Names:  _______________________________________________________________________ 



 

Names:  _______________________________________________________________________ 

_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________ 



 
 
 

Name: Lines: 

____________________________
____________________________
____________________________
____________________________ 

Name: 

Name: 

Name: 

Lines: 

____________________________
____________________________
____________________________
____________________________ 

Lines: 

____________________________
____________________________
____________________________
____________________________ 

Lines: 

____________________________
____________________________
____________________________
____________________________ 



Let’s think about 
acting... 

(a rubric to guide actors) 
 

Too quiet Too loud Just right 
 

Too fast Too slow Just right 
 

Reading 
cue cards 

Forgot the 
lines 

Just right 
 

Too 
fidgety 

Too frozen Just right 
 

Too 
excited 

Too boring Just right 
 

 



Let’s think about 
filming... 

(a rubric to guide directors and 
cinematographers) 

 
Blurry Just right 

Too much 
background 

noise 

Just right 

Camera in a 
weird position 

Just right 

Too much wait 
time 

Just right 

Too shaky Just right 
Background too 

busy 
Background 
too boring 

Just right 

Too close Too far away Just right 



What is our purpose for 
making the movie? 

*  
*  
* 
* 
* 

Who is our target 
audience? 

* 
* 
* 
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I
By Nikos Theodosakis

How Digital Filmmaking
Develops Higher-Order
Thinking Skills

f you scan the Hollywood box office report (variety.com) you will find the
names and rankings of the top grossing films in the United States. Monsters Inc.,
The Phantom Menace, Shrek, Harry Potter, and other multi-million dollar success

stories.

But here’s another list of important films produced this last year. My Family’s
Stories, Choices, My Dog Spot, Interview with a Civil War Soldier, My Family’s History,
Triangles, Friends.

Though these obscure cinematic experiments may never break box office
records, sell buckets of popcorn, or spin off merchandising memorabilia, they are
among the most important films being made today. In addition, the most influential
thinkers of the future, our children, are creating them.

Classrooms are turning into studios, teachers into producers and students
into filmmakers. Inexpensive and easy to use digital cameras and editing software
have enabled educators to explore the use of digital video as a serious tool for
teaching and learning.

While the benefits of filmmaking in the classroom encompass student
awareness, creativity, engagement, technical learning, it also provides a beautiful
bridge to life outside the classroom. This article looks at how digital video
production and filmmaking projects in the classroom can help develop higher-
order thinking skills.  In particular, I would like to explore how filmmaking provides a
framework for the development of higher-order thinking skills, from the students’
creation of the original idea to their first presentation and beyond.

Visioning
Filmmaking is about turning the intangible into the tangible. Regardless of the

size of the film, Ben Hur or My Science Experiment, movies start with that wonderful
thing called “the idea.” As the idea formulates, a vision of the final film begins to
develop. The challenge for students is to hold a clear picture in their mind of what
they want to communicate and then to guide their film towards that vision. The goal
is to put that vision on the screen.

http://www.vste.org
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Digital Filmmaking, continued

It is also about learning the process of looking at where you want to be,
looking at where you are now, and constructing a plan to connect the two. It is
about exploring not only what the vision is, but also what the vision does. How it
moves you into action, gets you up on your feet, and makes you advance in order
to crystallize what you have in your mind. It is important that students develop
visioning skills for both their present and future worlds. We need students to see
how ideas can be transformed into action and how if they want to reach for
something, if they can dream it, they can do it.

Research
When audiences go to see a film in the theatre, they seldom realize how

much research goes into the making of the movie. In the formative stages, writers,
directors and producers research story ideas that relate to the idea they are
imagining. They interview people, read books, clip magazine articles, scan the Web,
draw upon personal experiences and look to uncover information from anywhere
they can, knowing that key secrets can be revealed in the least likely of places.

Once an idea is decided upon, the filmmakers research in order to get a
better understanding of the context and content of the story. One of the
characters in my wife Linda’s latest screenplay works with autistic adults. Linda has
been researching autism on the Web, interviewing caregivers working with autistic
adults, and has arranged to work-shadow some of these caregivers and their
clients. The more she researches, the more it informs her story.

As information exponentially explodes all around us, the ability to effectively
mine that information also increases. If we are to prepare students to make sense of
all that information, then familiarization with good research skills —knowing where to
find things, how to find things, who to ask, how to collect it and how to organize it
—becomes another important skill developed by filmmaking.

Problem Solving
Turning the vision into the finished movie on screen requires a seemingly

endless journey into problem solving, not only in terms of what do we want to
show, but also, how we will show it.

As students set out to create their films and discover obstacles of time, of
equipment and of other resources, they learn to identify and solve their own
problems, and to own the process for finding solutions. It is then that these multiple,
real world filmmaking challenges have become a great opportunity to experience
real world problem solving.

Logic
Sometimes when I am putting together a film, I feel like I’m in the middle of a

giant algebraic equation. So many decisions in filmmaking are affected by so many
other decisions. IF it is sunny we WILL shoot Scene 16 by the lake with all the actors
and props required for that scene, BUT IF it rains THEN we will shoot the interior
scene in the cabin living room. There are so many decisions that are interwoven into
all of the other decisions that filmmaking requires the development and utilization of
good logical thinking skills.

http://www.vste.org
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In the classroom the process of filmmaking requires students to imagine what
they will need to make their movie. As they are asked to develop a strategy of
planning, production and editing, they start assembling a logical series of events and
resources to make it all come together. Regardless of whether this process is
articulated on paper, or simply considered in their minds, that process will occur.

Planning
A feature film is very rarely filmed in sequential order. This is because time,

money and other resources can be better utilized if similar scenes are shot at the
same time. Often these scenes are grouped by location, or by actors, or by
equipment availability.

Filmmaking in the classroom enables students to explore their own planning
and time management skills as they estimate, budget, schedule, analyze and revise
their filmmaking projects.

The results of poor or proper time management can be examined and used
as yet another learning tool in this process, so that there is a constant self-analysis of
what works and what does needs a new approach.

Analytical
Another skill which is invisible to the movie audience, but which is essential to

the filmmaker, is the ability to critically analyze information. As a director, when I am
standing on a film set, my role is to take in all the information about the scene that I
have researched and all the new information that I am receiving from the actors, the
crew or the location.  Then I analyze it against my vision for that particular scene. It is
about looking at all the information and deciding what should be included and what
should be left out. It is about filtering on your feet.

Later, during the editing process, I will look at multiple takes of the same shots,
and multiple shots of the same scene, and decide, after I look at all of this
information, which film footage best illustrates what I am trying to communicate and
what I want to explore. As long as we continue to be overloaded with information
and continual decision-making, the development of analytical processes will be an
important survival skill for students.

Beyond the Classroom
Now more than ever, filmmaking in the classroom can play a strategic role in

engaging student learning and in encompassing multiple educational objectives. The
goal here is really to enable students to experience these skills in the classroom as
part of the preparation for them using it in their own worlds beyond the classroom.
When students have opportunities to solve problems, budget, schedule, analyze,
research, plan, imagine and communicate their ideas to others, they are building real
world skills. And although their films may never be up on the big screen, the
experiences learned and the skills developed will make them much more than
better filmmakers, they will become better thinkers, and it seems that ultimately, this
is what this planet needs.

Digital Filmmaking, continued
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